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CHAPTER 1
Welcome to QuickBooks Advanced
Reporting

Welcome to Intuit QuickBooks Advanced Reporting! We're glad you’re here.

About QuickBooks Advanced Reporting

QuickBooks Advanced Reporting lets you use your QuickBooks data to create interactive reports and gain better

insights into your business.

In this guide, we’ll walk you through some of the basic principles and features of Advanced Reporting. We know it’s a
bit of a challenge, but there’s so much you can do with once you know how it generally works. Then, you can explore,

experiment, and build reports on your own.

You can choose from some reports we’ve created or build your own report from scratch. Either way, you’re able to

gain powerful insights into how your business runs

QlikView® Resources

QlikView®, a specialized reporting tool, powers QuickBooks Advanced Reporting. We’ve made it so QlikView® works
within QuickBooks and uses your company data. Here are resources that you may find useful as you use QuickBooks
Advanced Reporting, since the reporting portions (expression and dimension building, Properties window, etc) are
QlikView®.

Please note that not all the Qlik® documentation will 100% apply to Advanced Reporting since we integrated it into
QuickBooks. The Library in Advanced Reporting is an example of that. However, it will give you a great start in

understanding how to build reports.

Set Analysis Expression builder: http://tools.qlikblog.at/SetAnalysisWizard/QlikView-

SetAnalysis_Wizard_and_Generator.aspx?sa=

QlikView® Community: https://community.qglik.com/community/qlikview

Website: http://www.qlik.com/us/explore/products/qlikview

Demo Apps: http://www.glik.com/us/explore/products/qlikview/demo-apps

Video Resources: http://www.qlik.com/us/explore/resources/how-to-videos?language=english

New to QlikView Community: https://community.qglik.com/community/qlikview/new-to-glikview
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QlikView® Resource Library: https://community.glik.com/community/glikview/resource-library
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cHAPTER 2 Learn the basics

Give a user access to Advanced Reporting

Note that this is an “all or nothing” situation. If you give a user access, they will be able to use (and therefore, see) all

your company data to create reports within Advanced Reporting.

For example, if you set the user up as a Sales Person who can only see Customer and Sales data and you give them
access to Advanced Reporting, they can see everything in Advanced Reporting (but their permissions remain the same

throughout the rest of QuickBooks).
1 Signinasthe Admin.
2 Under the Company menu, select Users > Set up Users and Roles.
3 Click the Role List tab.
4 Select the role to give Advanced Reporting access to.
5 Alternatively, you can click New to create a new role.
6 Click Edit to edit your selected role.
7 Under Area and Activities, select File > QuickBooks Advanced Reporting.
8 Under Activity Access Level, click Full.

9 Click OK

Open up a report template or create your own from scratch

1 Click List.

2 Click any report.

3 Reports with 8] are templates that load with your data.
4 Start From Scratch opens a blank report.
5 Open your saved reports from here.

6 Click Open.
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The Library

The Library contains many pre-made objects that you can use to build your reports. We’ve already made charts, date

ribbons, Current Selection boxes, and much more.
7 If you don’t see the Library (a menu on the left side of the screen) click Library at the top.
8 Double-click an object to add it to the report.

= List Box: helps you filter charts and tables you have on the report

= Tables/Charts: display your data so it’s easy to understand

= Date: includes multiple Date Ribbons and List Boxes to filter your reports by date (see Date)
= Text and Utility: These objects help you filter even further, search for something specific, or

add titles and comments

9 Drag and drop to move the object around the report

Date

One section of the Library that is a bit more complicated than just adding objects is the Date section. It contains date
ribbons and list boxes that you can use to filter chart objects with specific dimension. These date ribbons and list

boxes are built around the concept that QlikView calls Master Calendars.

If you’re not familiar with the concept of Master Calendar and how it works, we suggested that you head over to the

Master Calendar section of this User Guide to learn more.

The table below shows all the objects that appear in the Date section of the Library. It gives a description as well as

the table or field that the object is made of.

Note: In order to see the data you expect, use these Date Library objects in tandem with other objects that contain
the appropriate or “matching” table or field in the Dimension. See the “Other objects must have a Dimension

that’s built using this Table/Field” column.

Date Library Object | Description Table/Field it’s Other objects must
made of have a Dimension
that’s built with fields
from this Table

Canonical (Date Ribbon) Filter on CanonicalCalendar CanonicalCalendar table

date for multiple table

transaction dates.

Canonical (M/Y) (List Box) Filter on date | CanonicalCalendar.Mon | CanonicalCalendar table
for multiple transaction | th Year field
dates. Shows last
payment made on
invoice by Month and

Year
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Canonical (Q/Y)

(List Box) Filter on date
for multiple transaction
dates. Shows last
payment made on
invoice by Quarter and

Year

CanonicalCalendar.Qua

rter Year field

CanonicalCalendar table

Customer Last
Invoiced

(Date Ribbon) Filter on
the date for the last
Invoice created for a

Customer:Job

CustomerlLastinvoicedD

atesCalendar table

CustomerlLastinvoicedDate

sCalendar table

Customer Last
Invoiced (M/Y)

(List Box) Filter on the
date for the last Invoice
created for a
Customer:Job. Shows
Month and Year.

CustomerlLastinvoicedD
atesCalendar.Month
Year field

CustomerLastinvoicedDate

sCalendar table

Customer Last
Invoiced (Q/Y)

(Date Ribbon) Filter on
the date for the last
Invoice created for a
Customer:Job. Shows

Quarter and Year.

CustomerlLastinvoicedD
atesCalendar.Quarter
Year field

CustomerLastinvoicedDate

sCalendar table

Customer Last
Payment

(Date Ribbon) Filter on
the date for last
payment made on a

Customer:Job.

CustomerLastPayment

DatesCalendar table

CustomerLastPaymentDate

sCalendar table

Customer Last
Payment (M/Y)

(List Box) Filter on the
date for last payment
made on a
Customer:Job. Shows
Month and Year

CustomerLastPayment
DatesCalendar.Month
Year field

CustomerLastPaymentDate

sCalendar table

Customer Last
Payment (Q/Y)

(List Box) Filter on the
date for last payment
made on a

Customer:Job. Shows

Quarter and Year.

CustomerLastPayment
DatesCalendar.Quarter
Year field

CustomerLastPaymentDate

sCalendar table

Transaction

(Date Ribbon) Filter on

all transactions.

Year, Month, Quarter
fields

_TransactionDateCalendar
table

Transaction (M/Y)

(List Box) Filter on all
transactions. Shows
Month and Year

Month Year field

_TransactionDateCalendar
table

Transaction (Q/Y)

(List Box) Filter on all

transactions. Shows

Quarter Year field

_TransactionDateCalendar
table
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Quarter and Year.

Transaction Last
Invoiced

(Date Ribbon) Filter on
the last invoice created

from a Sales Order.

TransactionlLastlnvoice

dDatesCalendar table

TransactionLastinvoicedDat

esCalendar table

Transaction Last
Invoiced (M/Y)

(List Box) Filter on the
last Invoice created
from a Sales Order.
Shows last invoiced for

Month and Year.

TransactionlLastlnvoice
dDatesCalendar.Month
Year field

TransactionLastinvoicedDat

esCalendar table

Transaction Last
Invoiced (Q/Y)

(List Box) Filter on the
last invoice created
from a Sales Order.
Shows last invoiced for

Quarter and Year.

TransactionlLastlnvoice
dDatesCalendar.Quarte

r Year field

TransactionLastinvoicedDat

esCalendar table

Transaction Last
Payment

(Date Ribbon) Filter on
the last payment made

on an invoice or bill.

TransactionLastPaymen

tDatesCalendar table

TransactionLastPaymentDa

tesCalendar table

Transaction Last
Payment (M/Y)

(List Box) Filter on the
last payment made on
an invoice or bill. Shows
last payment for Month

and Year

TransactionLastPaymen
tDatesCalendar.Month
Year field

TransactionLastPaymentDa

tesCalendar table

Transaction Last
Payment (Q/Y)

(List Box) Filter on the
last payment made on
an invoice or bill. Shows
last payment for

Quarter and Year

TransactionLastPaymen
tDatesCalendar.Quarter
Year field

TransactionLastPaymentDa

tesCalendar table

Transaction Last
Ship

(Date Ribbon) Filter on
the last ship date for a
Sales Order. This date is
pulled from the Ship
Date field on an invoice
that’s associated with
the Sales Order.

TransactionlLastShipDat

esCalendar table

TransactionLastShipDatesC

alendar table

Transaction Last
Ship (M/Y)

(List Box) Filter on the
last ship date for a Sales
Order. This date is
pulled from the Ship
Date field on an invoice
that’s associated with
the Sales. Shows last

invoiced for Month and

TransactionlLastShipDat

esCalendar.Month Year

TransactionLastShipDatesC

alendar table
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Year.

Transaction Last
Ship (Q/Y)

(List Box) Filter on the
TransactionLastShipDat
last ship date for a Sales
Order. This date is

pulled from the Ship

esCalendar.Quarter

Year

Date field on an invoice
that’s associated with
the Sales Order. Shows
last invoiced for
Quarter and Year.

TransactionLastShipDatesC
alendar table

Find the help center

1 Open QuickBooks Advanced Reporting

2 On the top right, click the (?).

B Repots v B ReportList
wey S 2 @ €@ P
Objects for your report
B List Box
B Table

ul Chart
A Text & Utility

Current Selection
Ribbon Date
Report Titie
Search All Fields
Report Subtitie
Comments

C Last Refresh: Today at 11:23 AM

Let the report building begin!

Double-click anything in the Library to add it to the report.
If you'd rather use our templates, you'II find them under List.

Looking for more help?
Check out the Getting Started Guide
Visit the Help Center
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cuaprter 3 USE Objects

Objects are the main items that you use in your report. They range from charts and tables to text and list boxes.

Edit an object in a report

1 Right-click on the object.
2 Select Properties.

3 Use the tabs at the top to edit the object

Delete an object in a report

1 Right-click anywhere in the blank space on the report. If you right-click on an object, you won't be able to
see the correct option.

2 Click Properties.

3 Click the Objects tab

| Genera | Fielddf | Obiects | fecurty | Triggers|
1S

ObjectlD  Type - Caption ShowMode CalcTime Layer Memory
LBO3 List Box INCOME ACCOUNTS Normal 0 0 0KB
LBO4 List Box EXPENSE ACCOUNTS Normal 0 0 0KB

‘ Delete Properties

OK | [ Camcel ][ pply

5 Select the object you want to delete. You can select more than one object using CTRL + click.

QuickBooks Advanced Reporting User Guide 9



6 Click Delete.

| General | Fields | Obiects | Security | Triggers |

ObjectlD  Type Caption
INCOME ACCOUNTS
EXPENSE ACCOUNTS

ShowMode CalcTime  Layer

Normal

o, [

8 Click OK to close the window.

Add a custom object

1 Right-click on any blank space in the report.
2 Select New Sheet Object.

3 Select the object you'd like to add.

QuickBooks Advanced Reporting User Guide
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cHAPTER 4 EXPressions and Dimensions

Overview

Two key items to building your report are Expressions and Dimensions. You'll use these to set up your data in tables,

charts, and other objects in Advanced Reporting.

Expressions: Requires a calculation and is what gives bars and lines in charts their height. Think of this as what comes

before the “per” in the statement “sales per country”. Sales is the expression.

Dimensions: How the data should be grouped. This think of this as what comes after the “per” in the statement “sales

per country”. Country is the dimension.

For example, here are the Properties for the chat in the Customer List template. The dimension is Customer:Full

Name, as seen under Used Dimensions.

Chart Properties [ ] .

Dimensions | Dimension Limits | Expressions | Sott | Presentation | Visual Cues | Style | Number [ Font [ Layout [ Cayl ¢ |

Available Fields/Groups
Account Account List ID B

Account.Account Number [

Used Dimensions

=[Customer Full Name]

Account Account Type < Remove

Account Active

Account.Balance Promote %

Account Balance Adjustment Exchange Rz

Account.Balance Home Amount Demote

Account Class Full Name ; -

Add Calculated Dimension... Edi...
Account Class List ID [ ] [ ]
[ Account Curency Full Name Settings for Selected Dimension

Account Currency List ID [] Enable Conditional

Account.Description

Account.Full Name

unt Has Attachments Suppress When Value Is Null
| Account Last Statement Date - .

Account.Name Show All Values

Account.Next Display Index Show Legend

Account Online % Label

T — » abe
D Show System Fields Customer E]
—— _—
Al Tables v [;]
Poe sk
No Breaks v
Animate Trellis
o) (o) [

QuickBooks Advanced Reporting User Guide

11



One of the Expressions used is Balance. You can see what the syntax for Balance is if you look under Definition and
click [...] to open it.

Chart Properties [ ] »

Enable [ Condtional

® [ Addr2

® [ city Label

@ [ State Balance )
# [ PostalCode Definition

* Main Phone II{(RowNo()),Customer.Balance) B
[+ Email

# [ Primary Contact Comment

Promote Group [7] Relative

[ Delete ] [ Demote Ungroup

' A Jation Display Options Total Mode )
© No Accumulation Representation (?:‘ No Totals |
© Full Accumulation Text - (© Expression Total
© Accumulate 10 = Steps Back ® | Sum v |
Trendines | i |
[[]Average - | Show Equation |
[ELinear (| [C]Show R Image Fomatting
E]« fobmomla{ Of %ﬂd d Y Fill with Aspect - |

[ ] Hide Text When Image Missing

o) [ ) [ oo ) [t

So if we were to apply the same logic as “Sales per Country” here, we would say “Balance per Customer” or “The

balance for my customer.”

Create a chart

1 Right-click any blank space in the report.
2 Select New Sheet Object.

3 Select Chart.

QuickBooks Advanced Reporting User Guide
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ADD OBJECTS TO THE REPOR’

B UstBox
B Table
Purchase Transactions

Sales Transactions

ul Chart

A Text & Utility

c Last Refresh: 1/2/2015 at 11:58 AM

Enterprise: Ad

o X

G Feedback @
EXPENSE ACCOUNTS Py e | Properties...
@ Autornobile Select Field:
Bad debt (@] Select Fields...
Bank Senice Charges New Sheet Object * [ (BNl ListBox...
Depreciation Expense Copy Sheet [Z)| Statistics Box..
Dues and Subscriptions 3 p .
Union Dues 4 Paste Sheet Object [E)| Multi Box...
Paste Sheet Object as Link ()| Table Box...
Print... Lil] Chart...
53 CopyImage to Clipboard [=)| Input Box...
Export Image to File |@ Current Selections Box...
Customize Toolbar @] Eatons
(A} Text Object...
o) rep Al j
[S)| Line/Arrow Object...
A Remov
L Remove [@] Slider/Calendar Object...
3| Bookmark Object...
(@)} Search Object...
Vendors p ; <
. |@ Container...
Vendor _. City Sta
(@) Custom Object...
A Cheung Limited Berkeley CA) limited.com
Bank of Anycity Middlefield Al System Table \ame.com
Bayshore CalOil Service Bayshore CA 98323 415-555-7378
Bayshore Water Bayshore CA 94326 415-555-0111
Bruce's Office Machines Millbrae CA 94030 650-555-8923  banderson@myemail.com
C.U. Electric Bayshore CA 94326 415-555-0797 cu-service@samplename.com
Cal Gas & Electric Middlefield CA 94482 415-555-0202
Cal Telephone Middlefield CA 94482 415-555-5555
CalOil Company Middlefield CA 94452 650-555-0912
City of Bayshore Bayshore CA 94326 415-555-1000
City of East Bayshore East Bayshore CA 94786 650-555-0101
City of Middlefield Middlefield CA 94482 415-555-8500
Custom Kitchens of Bayshore Bayshore CA 94326 415-555-2828 CKBservice@samplename.com
Daigle Lighting Middlefield CA 94482 415-555-7769  info@samplename.com

Davis Business Associates

415-555-2874

Save

kdavis@samplename.com

Close

4 The chart building wizard starts with the title and type of chart you want.

5 Enter your chart title under the Show Title in Chart checkbox

6 Window title can be the same if you like. It just is what appears on the top bar of the chart window.

7 Select the type of chart you'd like to see your data in.

QuickBooks Advanced Reporting User Guide
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f o

Window Title
Test

Show Title in Chart
Test

Detached
Read Only
Calculation Condition

Chart Type Fast Type Change
Allowed Types

[~ BarChart -
[ Line Chart
[~ Combo Chart H

[ Scatter Chart

| [~ Pie Chart
= Wl Pivot Table

[~ Straight Table -

Reset Prefemed Icon Position
— Reference Mode: ©) In Chart

[Reset User Docking | | Emor Messages.. | Dimmed © In Caption

8 Click Next.

9 Select your Dimension. Usually, you’ll want to know more about your transactions so a good rule is to
make choices from the Transaction table. We’ll use it in our example so you can see it.

10 From the Show Fields from Table menu, click Transactions.
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B JobType

Lead
DR LeadAdditionalContact

LeadToDo

! Din LiabiltyAccount
OtherName
OtherNameAdditionalContact
OtherNote
PaymentMethod
Payrollitem
PriceLevel
PriceLevelltem
SalesRep
SalesTaxCode
Serial Number
ShippingMethod
ShipTo
Ship ToEntity
SiblingAccount
TaxCode
Tems
TransactionltemCustomFields
TransactionNameCustomFields
Transactions
TransactionSerialNumbers
UnitOFMeasure Unit
Vendor
VendorAdditionalContact
VendorCustomFields
VendorNote

All Tables

| Animate... | [ Trelis..

H

Remove

~

Promote

Demote

Used Dimensions

| Add Calculated Dimension... | [ Edt...

Settings for Selected Dimension
[] Enable Conditional

| J

[ Suppress When Value Is Nul
[] Show All Values

[] Show Legend

[] Label

‘-ruse field name= ’

™

Comment

Page Breaks

‘ N ‘

11 From the Available Fields/Groups menu, select anything you’d like to see as the Dimension, or the word

[ <Back [ Net> | [ Fiish

J [ Concel | [ Heb |

after “per” in our “Sales per Country” example. In this case, we’ll select Transactions.Customer Full Name.

QuickBooks Advanced Reporting User Guide
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Available Fields/Groups

Transactions.COGS Amount

Transactions.Condensed
Transactions.Cost < Remove
Transactions.Credit Amount In Home Curre:
Transactions CreditRemaininginHomeCurmre Promote
4 Transactions .Cumency List ID @ ————
Transactions.Curency Name Demote
—
& Transactions.Customer List 1D ’ i Coic it ol Dimension l ’ Bl
Transactions.Customer Message Name Settings for Selected Dimension
4 Transactions .Customer Msg List ID [ Enable Conditional
4 Transactions .Customer Sales Tax Code Lis
Transactions .Customer Sales Tax Code Na ‘
Transactions. Debit Or Credit [] Suppress When Value Is Null
Transactions.Delivery Date
Transactions.Deposit Total (] Show All Values
Transactions.Deposit Total In Home Cu [] Show Legend
Transactinns Il");annsded D Label

<

[] Show System Fields

Show Fields from Table Comment Advanced...

Transactions

Edit Groups...

‘=ueeﬂe[c name= |

Page Breaks

[ Animate.. | [ Trelis..

12 Click Add.
13 Click Next.

14 Now it’s time for Expressions. These are the words before the “per” in our Sales per Country example.
Depending on what you want to see, you could make a lot of choices here. We'll start with “Active

transactions per Customer.”
15 From the Table menu, select Transactions.
16 From the Field Menu, select Transactions. Active.
17 Click Paste.

18 Click OK to save.
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1| Transactions.Active

Transactions.Active ltem |

<4

Fields | Functions | Variables | Images |

Agaregation ‘ 0

Table Transactions [] Show System Fields

Field Transactions.Active [] Distinct

0K ][ Cancel ][

19 Click Finish to see your chart or Next to do more with your chart.

Expressions we’ve created for you

We've created some expressions (called variables) that you can use in your reports. That way, you don’t have to write
these Expressions yourself.

Here’s where you can find them

1 Right-click on an object.
2 Click Properties.
3 Open an Edit Expressions window.

= Click the Dimensions or Expressions tab
= Select any Dimension or Expression.

. Dimensions: Click Edit.

. Expressions: Double-click Expressions name or click [...] under Definition.
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Expression 0K

sum(If (Match([T:

ions.A

[N

Fields | Functions | Variables | Images|

Type], 'A

Receivable') and (Transactions.Pending = 0 or IsNull(Tran: 4
if ((Match ([Transactions.Txn Type], 'Receive Payment',

'Credit Memo',

'CreditCardCredit') or (Match ([Transac’

- vAmountWithSignColumn
vhnd
El vContactNameFieldCount
— vContactNameFieldName
* vCustomFieldName

vExpDayRangeFilter
vExprLast1 2MonthsRolling
vExprMaxYear
vExpiPreviousNMonths
vExpPreviousNQuarters
vExprPreviousNYears
vExprSales
vitemCustomFieldCount

vSetSoldQuantity
. vSkipMergerHeaderdndLines
vTxtMonthYear
vTxtQuarterYear

vTxtYear

m

pe], 'Receive Payment’',

unt Type], 'Accounts Receivable') and (Transactions.Pending = 0 or IsNull(Tran:

'Credit Memo', 'CreditCardCredit') or (Match ([Transac’

0
Show System Variables

0

| ok

J [ Concel |[ Heb |

QuickBooks Advanced Reporting User Guide
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Understanding how to use them

If you choose a variable from the list, you’ll see what data was used to put it together.

r ~
@ Edit Expression E@g
i File Edit Settings Help

Expression 0K

sum( {$<$ (vExprDayRangeFilter (545,365))b $(vExprSales)>} [Transactions.Quantity With Sign])

Vaitls
vExprPreviousNQuarters -

[Quarter ID] = {$(=Max([Quarter ID]) - $1)}, Year=, Quarter=, Month=, Period=, [P¢ »

< |

| [ ok ]| cancel || Hep |
vSet: Is a complete expression on it's own and can be used in a set. Includes vExpr variables.

vTxt: used as label, you can put it in a text area to turn it into something like a date, etc

VExpr: meant to be used in set analysis as a part of an Expression.

o VExprSales and vExprDayRangeFilter are used in the Item Sales Forecast report template (look under

Expressions in Properties for the Sold last column). When you use something like vExprSales in a set, it already

includes certain factors relating to your Sales. That way, you don’t have to build the expression each time.

QuickBooks Advanced Reporting User Guide
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Se

t Analysis with variable example

— -
@ Edit Expression L e - —— b - lElm
File Edit Settings Help
Expression 0K
sum({<$ (vExprCogs) >L[Iransactions.Amount With Sign] )| -
\ Modifier begins
) and ends with < >
Set analysis
begins and '
ends with {} Use the S before '
the variable. )
I |
I
Another example:
sum({<$(vExprSales),§(vExprPreviousNYears(0))>}Transactions.Quantity With Sign])

< | 1 »

Fields | Functions | Variables | Images|

Aggregation v 0 %
Table O All Tables v [ 7] Show System Fields
Field Account.Account List D v Distinct

ok (e ) e )

List of pre-built expression syntax

VvExprCogs: This variable can be used in set analysis when you want to do anything with the cost of goods sold
for sales transactions. This is used in the Sales Profitability starter report to calculate the Total Cost of Products
and Services.

vExprDayRangekFilter: Use this expression as a modifier in set analysis to restrict the calculation between two
dates.

vExprLastl2MonthRolling: Use this expression as modifier in set analysis to calculate amount or quantity for last
12 months. This is used in the Library object Sales -Top 10 item- last 12 months.

vExprMaxYear : Use this expressions as a modifier in set analysis to make sure that you always have value for the
max year of the current selection.
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o For example, if you use it sum({<$(VExprMaxYear)>}[Transactions.Amount]) and we select a particular year
then the amount will be shown of that year. If you select more than two years, then the amount for the latest

year shows.

¢  vExprMonthRangeFilter: This is same as vExprDayRangeFilter. It just works on monthly basis. In
fact, vExprLast12MonthRolling is just a specific implementation of it.

¢ vExprPreviousNMonths: Use this is as a modifier in set analysis. It produces a value for a particular month and
takes one parameter. Use O for current month, 1 for previous month, and so on. You need to remember that
these all work based on the current selection of dates. If you select Q2 of 2013, then the expression
SvExprPreviousNMonths(0) points to the June 2013.

¢ vExprPreviousNQuarters : Same as vExprPreviousNMonths.

¢  vExprPreviousNYears: Same as vExprPreviousNMonths .

*  vExprSales: Use this as modifier in set analysis to filter your data only for non-pending sales transactions.
¢ vExprQuarterRangeFiter: Same as vExprMonthRangeFilter.

*  vExprYearRangeFilter: Same as vExprMonthRangeFilter.

e  vSetSalesincome: The sum of your sales income (as expressed in vExprSales).

*  vSetSoldQuantity: The total quantity of your sales income (as expressed in vExprSales).

¢ vTxtMonthYear: This can be used to label your expressions. It goes hand in hand with vExprPreviousNMonths. If
you use $(vExprPreviousNMonths (0)) in your set analysis, then you should use $(vTxtMonthYear(0)) as the
label of this expression. If you want to have months in your dimension, then you can use [Month Year]
in your dimension.

¢ vTxtQuarterYear: Same as vixtMonthYear. In a dimension you can use [Quarter Year].

*  vTxtYear: Same as vTxtMonthYear. In a dimension you can use [Year].
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cuarter 5 Master Calendar

What is a Master Calendar?

A Master Calendar table is a dimensional table that links to dates in your company file data. It includes one record per

date for the minimum and maximum dates in your company file.

The first Master Calendar that was built into Advanced Reporting was for transaction creation date for all transaction

types.

To get a better picture of how this looks in a table, here’s an example:

Month Month Year Transactions.Txn Date

N oy s LLJIANIIN

Essentially what you’re seeing is a detailed presentation of Dates in the company file. You can use this to filter your

reports and we’ve built it into the Library under Date > Transactions. This will show creation date for all transaction

types.

Let’s walk through how to use dates like this in a simple report that shows transaction date for Month/Y ear:

1 Right-click anywhere in the white space.
2 Choose New Sheet Object > Chart.

3 Click the Pivot Table button.
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4 Click Next.
5 From the Available Fields/Groups column, select Month Year.
6 Click Add.

7 From the Available Fields/Groups, select Transactions.Txn Type. You can narrow down the table to

Transactions only by selecting Transactions from the Show Fields from Table drop-down.
8 Click Add.
9 Click Next.
10 In the Edit Expression window, type sum().
11 Click between the parentheses so your cursor is in-between (and ).
12 Under the Field tab, select Transactions from the Table drop-down.
13 In the Field drop-down, select Transactions.Amount With Sign.
14 Click Paste.

At this point, this chart just shows the use of Master Calendars and doesn’t reflect the right amount for any

transactions. Use different expressions to show that. Here’s an example.

15 Modify the expression to read: sum({<[Transactions.Header Or Line]={Header}>}[Transactions.Amount
With Sign])

= Transactions.Header Or Line, with Header selected gives the transaction amount.

16 Click OK.
17 Click Finish.

So now you can see that you’ve bucketed these transactions based on month and year. There are totals based on all

transactions according to the Month/Year that they were created.

What if you wanted to see invoices, bills, or jobs based on their last
payment date?

The first Master Calendar used transaction date, which is equal to the date the transaction was created. We added

more Master Calendars that use different sets of dates: the transaction payment date.

These Master Calendars use the following tables:

. TransactionLastPaymentDatesCalendar: uses the dates Invoices or Bills were last paid. You can use it to bucket
your invoice or bills according to the date of the last payment.
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*  CustomerLastPaymentDatesCalendar: uses the dates that jobs were last paid. You can use it to bucket your
Customer:Jobs according to the date of the last payment. See an example of this table is the Job Activities Over
Time template.

What if you wanted to see Sales Orders or Customers based on their
last invoiced date?

There are more Master Calendars that use different sets of dates: last invoiced dates.
These Master Calendars use the following tables:

. TransactionlLastinvoicedDatesCalendar: uses dates based on Sales Orders. You can use it to bucket your Sales
Orders according to the date of the latest invoice created from a Sales Order.

*  CustomerlastinvoicedDatesCalendar: uses dates based on Customer:Jobs. You can use it to bucket your
Customer:Jobs according to the date of their latest invoice.

What if you wanted to see Sales Orders based on their last shipped
date?

There is another Master Calendar that uses a different set of dates: last shipped dates.
This Master Calendars use the following table:

*  TransactionlLastShipDatesCalendar: uses dates based on Sales Orders. You can use it to bucket your Sales Orders
according to the last shipped dates.

What if you wanted to see transactions based on more than one
date?

You should use the CanonicalDatesCalendar table.
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Let’s look at an Canonical date example that you can find in the Library:

Invoiced Vs Paid ~
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The Dimension for this chart is CanonicalCalendar.Month Year. It’s used with the expressions:

. Invoiced: (sum({<DateBridge.DateType={'TransactionDate'}, [Transactions.Txn Type]={'Invoice'},
[Transactions.Header Or Line]={'"Header'}, Transactions.Pending={0}>}[Transactions.Amount With Sign])

*  Paid: sum({<DateBridge.DateType={'LastPaymentDate'}, [Transactions.Txn Type]={'Invoice'},
Transactions.Paid={1}, [Transactions.Header Or Line]={'Header'}>}[Transactions.Amount With Sign])

Couple things to take note of in these expressions:

. DateBridge table, with the field pointing to LastPaymentDate. This table includes dates from other tables like
Transactions and TransactionlmportantDates. DateBridge table has a field called DateType that identifies the
origin of the date. If you want to bucket your transactions according to more than one date, then use DateBridge
in your expression the way it’s used in Library objects “Invoices vs Paid” and “Sales Order Created vs Sales Order
Shipped.”.

*  Transactions.Header Or Line, with Header selected gives the transaction amount.
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